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INTRODUCTION

                        

General Information
Chapter 1:  Introduction to QuickLog 
for Windows

Thank you for selecting an OMEGA data acquisition system for your project!

Our primary objective is to provide you with data acquisition systems that are 
easy to install, operate, and maintain. We also strive to provide the perfor-
mance and versatility you need at the lowest overall cost. The benefits for you 
are increased productivity, data you can count on, and, of course, meeting 
your cost and time budgets.

QuickLog for Windows (QuickLog) is a menu-driven data acquisition soft-
ware application that is supplied with all of our WB and DATAshuttle series 
data acquisition hardware products. It has an easy-to-use tabular interface 
which brings simplicity to the laboratory and industrial environments, allow-
ing you to set up a typical data acquisition application in less than 30 min-
utes!

Using QuickLog, together with our plug-in data acquisition boards and/or 
parallel port DATAshuttles, you can easily and quickly implement a broad 
spectrum of R&D or industrial tasks, in a wide variety of settings. You can, for 
example,

·    Display data in meters and charts,

·    Automatically linearize thermocouples and RTDs,

·    Monitor processes and experiments,

·    Log data to disk for later analysis,

·    Control devices using digital outputs, 

·    Gather data unattended, and

·    Exchange data with other Windows applications via DDE.

This chapter shows how to install the QuickLog software. Please refer to Chap-
ter 2 for instructions on operation.
QuickLog for Windows Owner’s Manual
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WHAT YOU NEED

SYSTEM
REQUIREMENTS

MINIMUM
REQUIREMENTS

 

General Information
These are the items necessary to start using QuickLog:

·    This manual

·    The QuickLog disk, and

·    A data acquisition device (connected to your PC according to 
the Owner’s Manual).

QuickLog works with most Wintel personal computers (PCs with 
Intel, or Intel-like CPUs, running Windows) available today. The 
minimum software and hardware requirements your PC needs to 
run QuickLog successfully are listed below. To get the best perfor-
mance from the software, especially when more than one Win-
dows application is to be run, we recommend additional 
hardware resources.

A personal computer with a 386 processor, a standard keyboard, a 
mouse or similar pointing device, and

·    4 MB memory (RAM),

·    2 MB of free hard disk space

·    3.5" diskette drive,

·    A monitor and a VGA display adapter supported by Windows,

·    One parallel interface (Centronics) if using a DATAshuttles, 
and

·    DOS (v5.0 or later) and Windows (v3.1or later) or Windows 95. 
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Setting Up
Setting Up QuickLog

Make sure that your QuickLog package is complete. In addition 
to this printed document, it should contain a floppy disk, the 
Hardware Installation Manual, and the registration card.

Make sure that there is at least 2 MB of free space on the hard 
disk on which you intend to install QuickLog.

Insert the QuickLog disk into the floppy disk drive.

For Computers Running Windows 3.x – 

1.  From the File menu in Windows Program Manager, choose Run. The 
Run dialog box will appear.

2.  In the command line, type the drive letter of the drive you are 
using, followed by a colon and the QuickLog installation pro-
gram file name, SETUP. (You may type upper or lowercase 
letters.) For example: A:SETUP

3.  Press the Enter key. The QuickLog installation program will 
start.

For Computers Running Windows 95 – 

1.  Open the Control Panel. 
2.  Select Add/Delete Programs.
3.  Windows 95 will search for the installation disk. Select finish and 

the QuickLog installation program will start.

You can exit the installation procedure any time by clicking the 
Cancel button. However, QuickLog will not be completely and 
properly set up.

You will be asked to specify the drive and the directory where 
QuickLog is to be installed. The default is C:/QLFW. You may 
type a different path, but it must be a valid MS DOS path:

Drive:/ Directory/Directory

Then choose OK. The installation program will:

·    Check if the specified directory exists, and create it if necessary. 

·    Check if there is enough free space on your hard disk. If not, 
you will be asked to enter another drive or to cancel setup.

E
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COMPLETING SETUP

METER DISPLAY
SCREENS

 

Specifications
·    Copy all QuickLog program files to the drive and directory.

·    Create a QuickLog program group in the Windows Program 
Manager. If the group already exists, it will be opened.

·    Create various program items within that group.

·    Add the command line DEVICE=DRIVE;/DIRECTORY/
DIRECTORY/.../STIDATAQ.386 to the [386Enh]section of the 
SYSTEM. INI file to install the virtual device drive needed to 
communicate with the hardware.

Restart Windows so that the changes made to your system can 
take effect, so that the driver will be loaded.

Specifications

Types of I/O Supported – Analog In, Analog Out, Digital In, Digital 
Out, Counter/Timer pulse input, Counter/Timer frequency input, 
and Time.

Maximum Number of Data Acquisition Devices – 15

Maximum Number of Channels Per Board – 160. Channel name and/or 
units may be typed in.

Analog Input Ranges Supported – all that are supported by the data 
acquisition driver.

Analog Input Resolution Supported – all that are supported by the 
data acquisition driver.

Analog Output Ranges Supported – all that are supported by the data 
acquisition driver

Scaling of Any Input Type – linear, y=mX + b.

Outputs (analog or digital) may be changed by typing the value 
into the digital meter.

Size of Digital Meter Display – selectable height and width.

Number of Digital Meters – selectable from 1 to 100.
n
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Specifications
Single chart with selectable time scale. Y axis is % of specified 
range or user entered maximum and minimum range. Includes 
the scaling specified in the digital meter display.

Chart is a window that may be sized as desired.

Types of I/O Supported – Analog In, Digital In, Counter/Timer 
pulse input.

Number of Traces Displayed – 14 maximum.

Data Type – ASCII characters, tab-delimited.

Maximum Number of Logged Channels – 256

Log Rate – same as sample rate

Types of I/O Supported – Analog In, Digital In, Counter/Timer 
pulse input.

Any meters may be linked to another application using DDE.

Inputs can be sent, and outputs can be received, from the other 
source.

DDE Rate – same as sample rate, or same as rate requested by 
other application.

The following settings are available for the general configuration 
of QuickLog:

·    Sample rate: same for all channels, inputs and outputs,

·    Polled or synchronous mode for all types: Analog In, Analog 
Out, Digital In, Digital Out, Counter/Timer pulse input, 
Counter/Timer frequency input,

·    Polled mode: maximum speed is several samples/second,

·    Interrupt mode: maximum speed is several hundred samples/second,

·    Number of input meters,

·    Input meter font size,

·    Log file name, and

·    Number of output meters.

·    Output meter font size.
QuickLog for Windows Owner’s Manual
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Specifications
The input and/or output of each channel can be configured using 
these options:

·    Device (board)

·    Channel

·    Range (AI and AO only)

·    Resolution (AI only)

·    Scale (AI only): y = mx + b where m and b may be entered.

·    Logging: yes/no.

·    Display on chart: yes/no.

Charts can be configured according to these available settings:

·    Number of points on time axis (2 to 1000)

·    Number of labels on time axis

·    % of full scale on Y axis (0 to 100)

·    Scaling of Y axis: -1e10 to 1e10 

·    Selectable options: 
Color for each trace
Line type for each trace
Chart Colors

·    Viewing Style: Color, monochrome, monochrome + symbols

·    Plotting method: Line, Point, Points + Line, Points + Spline, 
Spline

·    Graph or Table: Graph, Table, Both

·    Grid Lines: Both, Y axis, X axis, None

·    Grid in front

·    UnZoom

·    Font size: Large, Medium, Small
n
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General Information
Chapter 2:  Getting Started

QuickLog is entirely menu-driven. You control data acquisition, display, and
disk logging by configuring QuickLog via the pull-down menu system.

QuickLog is based on one display screen of digital meters that are used to dis-
play all types of available inputs, and another screen for all types of available 
outputs. In addition, it displays input signals on a Y-t chart, as well as logs 
these inputs to disk.

You can change the name on each input or output meter to identify it.

When you first launch QuickLog, it searches for hardware devices, first on 
the ISA bus inside the PC, and then on all installed printer ports. It then cre-
ates Input, Output, and Chart windows that reflect the installed hardware.

QuickLog runs, and collects and displays input data, as soon as it is launched. 
It continues to run when you are configuring the various options. If you load 
a configuration file that does not match the installed hardware, it automati-
cally adjusts the configuration file to match the hardware, and displays a 
warning message.

This chapter briefly explains the various menus, with a description of their 
functions. QuickLog also has an extensive on-line Help facility, which has 
more information than what is contained here.
QuickLog for Windows Owner’s Manual

2 – 1



 

QUICKLOG FOR WINDOWS OWNER’S MANUAL

 

Chapter 2 Getting Start

 

2 – 2

                     

SAVE AS STARTUP

PRINT WINDOW

EXPORT CHART
EXIT

PASTE LINK

 

The File and Edit Menus
File Menu

Standard functions include those for creating, loading, and saving 
configurations. These are New, Open..., Save, and Save As. Select 
New to revert to the default configuration. Other file menu com-
mands and their functions include:

The Save As Startup command allows you to define your own 
startup configuration, using your desired settings.

Print Window immediately prints the active top window, using 
the default Windows printer. 

Export Chart to the Windows clipboard, a file, or to your printer. 

Exit closes the program.

Edit Menu

Cut, Copy, Paste, and Delete are standard editing functions.

Paste Link allows you to paste DDE links from another applica-
tion into an output meter.
ed
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SAMPLE AND
LOG RAT

MOD

INPUT METERS

OUTPUT METERS

The Options Menu
Options Menu: General 

You may select the Sample Rate, in Hz, which is the rate of reading 
and displaying inputs and logging to disk. The maximum rate 
depends on the Mode you have selected, the speed of your PC, 
and the data acquisition hardware installed.

The Polled (or Asynchronous) mode samples at the rate set by the 
application, and is the slowest data acquisition rate. This mode 
does not use interrupts for most data acquisition devices. How-
ever, this mode is the simplest to use.

The Interrupt (or Synchronous) mode samples at a precise rate set by 
the driver, and allows much faster sampling. Most data acquisi-
tion devices generate hardware interrupts to pace the driver, and 
thereby set the rate.

Refer to the on-line help for more information about these modes.

When first launched, QuickLog detects the hardware installed, 
and creates a default user interface made up of a table of win-
dows, called Input Meters, which display the analog, digital, or 
Counter/Timer values being sampled. You may change the num-
ber of Meters being displayed, as well as the number of horizon-
tal and vertical Meter windows, using the General Options menu. 
Color and font size are also selectable.

You may set up the Output Meters in the same fashion as 
described above, if you have a device installed that has analog or 
digital outputs.

E

E

QuickLog for Windows Owner’s Manual

2 – 3



QUICKLOG FOR WINDOWS OWNER’S MANUAL

Chapter 2 Getting Star

2 – 4

WINDOW LABEL

ANALOG INPUT
RANGE

RESOLUTION

SCALE

LOG & CHART

The Options Menu
Options Menu: Inputs 

This window allows you to define which readings will be dis-
played in the Meter window. You may select data acquisition 
Device 1 through 15, the input Function...None, Analog In, Digital In, 
Pulse In, Time, Date (from the PC clock), and which Channel on that 
device will be assigned that input function.

The first column accepts a typed in label for that Input Meter win-
dow, in place of the default label.

When you select Analog In, you may select the input Range from 
a table that will depend on the ranges available on the device you 
have connected to your PC.

The column Resolution allows selection of A/D resolution, again 
dependent on the device connected. Some devices allow for aver-
aging the samples to reduce noise. Also, Low Noise mode is effec-
tive in greatly reducing AC line interference.

When you click on the radio button Scale = mX + b, a new field 
opens to allow you to enter coefficients for a linear scaling of the 
analog input readings into engineering units

Log and Chart columns allow you to select whether this channel 
will be logged to disk and/or displayed on the Chart. At least one 
channel must have the Log box checked to have logging to disk. 
At least one channel must have the Chart box checked to have a 
trace on the chart.

Options Menu: Output Meters

The functions in this menu are similar to the Input Meters 
Options menu described above, but these selections operate on 
the output signals: Analog and Digital. 
ted
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OPTIONS MENU
COLORS AND LINES

UNDO ZOOM

CHART ZOOM

OTHER OPTIONS

The Chart and Run Menus
Options Menu: Chart

This window allows you to customize the appearance of the Y-t 
Chart display. All of the parameters are available in one window, 
as opposed to the function of the Chart menu described below, 
where an abbreviated set of attributes are accessible separately in 
the menu.

Chart Colors and Lines can be used to select colors and line types 
on the chart.

Chart Menu

Unlike the Options menu, these selections do not cause the Chart 
data to be erased.

Undo Zoom allows you to cancel a Chart zooming operation; 
alternatively, use the keyboard shortcut Ctrl+Z.

Chart Zoom allows you select a region of interest in the data, and 
expand it to fill the Chart display window. Place the cursor at one 
edge of the region of interest, and hold the left mouse button 
down. Move the cursor to draw a box around the region, and 
release the mouse button. The region will expand to fill the win-
dow. The X and Y scales will also expand to maintain the proper 
scale.

The balance of the menu items, Viewing Style, Font Size, Plotting 
Method, Grid Lines, Grid in Front, and Graph or Table, are direct menu 
access to the same items as in Options, Chart. Refer also to the 
on-line Help.

Run Menu

To Start the acquisition, press F5; to Stop, press F6. When acqui-
sition is running, a green Running indicator lights up at the left 
edge of the menu bar; when stopped, the indicator turns red.

:
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CALIBRATE ANALOG
INPUTS

AUTOCALIBRATE

CALIBRATE ANALOG
OUTPUTS

CHANGE NUMBERS

INSTALLED
HARDWARE

The Window, Calibration and Help Menus
Window Menu

This menu allows you to pull the Input (F9), Output Meter (F11) 
displays, and the Y-t Chart (F12) to the foreground of the screen.

Calibration Menu

When you click on this entry, the analog input circuits of all devices 
are immediately calibrated against their respective internal preci-
sion voltage references, which compensates for drift and offset.

You may select the interval at which you wish to invoke the above 
calibration function.

This selection calibrates analog outputs on some hardware.

CAUTION: Outputs are changed from minimum to maximum on 
all ranges during calibration.

This utility allows you to perform a complete recalibration of the 
device. If you follow the instructions given in the Help file, you 
can restore the device to the original factory accuracy. However, 
please observe the cautionary statement in the window, and in 
the Help file.

Help Menu

The Help menu provides on-line help for QuickLog. The on-line 
help is a complete guide to the use of QuickLog, with much more 
information than this manual.

Installed Hardware is very helpful when calling our Technical 
Support people. The information contained in this window will 
help speed the answers to your application and troubleshooting 
questions.
ted
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